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Abstract:

Sandwich theory describes the behavior of a beam, plate,
or shell which consists of three layers - two face sheets
and one core. The most commonly used sandwich theory
is linear and is an extension of first order beam theory. Lin-
ear sandwich theory is of importance for the design and
analysis of sandwich panels, which are of use in building
construction, vehicle construction, airplane construction
and refrigeration engineering. Sandwich cross sections
are composite. They usually consist of a low to moderate
stiffness core which is connected with two stiff exterior
face-sheets. The composite has considerably higher shear
stiffness to weight ratio than an equivalent beam made
of only the core material or the face-sheet material. The
composite also has a high tensile strength to weight ra-
tio.

This laboratory exercise investigates the fundamental
aspects of designing composite sandwich panels. Com-
posite sandwich panels are used in applications that re-
quired a light weight, high strength structure. Common
applications of sandwich panels that students maybe fa-
miliar with are surfboards, wake boards, and corrugated
cardboard. Sandwich panels are often used in aerospace
applications, such as wing flaps, aircraft floors and over-
head storage bins. we build, test and analyze the strength
and stiffness of composite sandwich panels from readily
available materials.Hence our intension is to do the analy-
sis on a well designed sandwich panel arrangements used
for Aircraft Wing & fuselage Structures & other Defense
applications by using ANSYS.

INTRODUCTION (Heading 1):

Composite materials are widely used in today’s mod-
ern world. With the advent of new materials, production
techniques and new application areas, etc., composite
materials have become one of the most attractive
areas in engineering.
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As in many areas of engineering, generic applications are
based on analytical methods and with the increasing
complexity of the geometries, boundary conditions and
material, in almost every case, the use of analytical meth-
ods become very tedious if not impossible. At this point,
the use of computational methods comes into picture.
With the help of computational methods, namely finite el-
ement method (FEM) for structural analyses, highly com-
plicated problems can be handled with great accuracy.
The disadvantage of using computational methods is that,
in order to get accurate results, too much computational
time is needed, and this increases when the problem be-
comes more complex. In addition, FEM models require a
detailed study before the model is sent to the solver.In this
thesis, honeycomb structures (HC), which is a specific
type of composite structure are investigated. HC struc-
tures are mostly used in sandwich structures. Because of
the web-type structure of the HC’s, the sandwich structure
made from HC'’s is relatively complex from the modeling
and analysis point of view. The goal in this post-graduate
study is to generate an orthotropic equivalent model that
can be used instead of the honeycomb structure itself.
Thus, a great decrease in the preprocessor time and com-
putation time can be achieved.

The generated equivalent model can be used mostly in
the preliminary design stage of the design process. Be-
cause of the nature of the preliminary design stage, the re-
quirements, the geometries, and the loads of any kind,
change very often, which resolves the problem to get
the results for the updated design. In addition to these,
there are many different HC’s with different cell sizes,
wall thicknesses and material that can be readily found on
the market. Hence, instead of using a finite element model
that fully models the details, an equivalent model an be
used to reduce the time spent for the analysis of the
HC structure. In the following chapters, it will be seen
that the equivalent model gives macro scale results, which
means that in order to get the results for the micro scale,
i.e. the stresses on the cell walls and local displacements,
a more detailed 3-D model should be used.
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I.LEASE OF USE:

A composite material is made by combining two or more
materials to give a unique combination of the properties
of the constituent materials. The advantage of the com-
posites is that they usually exhibit the best qualities of the
constituents and some qualities that neither constituent
possesses. The properties that can be improved include.

COMPOSITE MATERIALS:

A composite material is made by combining two or more
materials to give a unique combination of the properties
of the constituent materials. The advantage of the com-
posites is that they usually exhibit the best qualities of the
constituents and some qualities that neither constituent
possesses. The properties that can be improved include:

*Strength

Stiffness

eCorrosion resistance
*Wear resistance

e Attractiveness
*Weight

*Fatigue life

eThermal insulation
*Thermal conductivity
*Acoustical Insulation

The composite materials are not “new”. Since ancient
times mankind has used composite materials in different
areas. Straw was used to strengthen mud bricks. Medieval
swords and armor were constructed with layers of differ-
ent materials. In the Mongolian arcs, compressed parts
that are made of corn, and stretched parts that are made
of wood and cow tendons were glued together .

Although the use of composite materials is not new,
the history of modern composites probably began in
1937 when salesmen from the Owens Corning Fiberglass
Company began to sell fiberglass to interested parties
around the United States. In 1930, fiberglass had been
made, almost by accident in 1930, when an engineer be-
came intrigued by a fiber that was formed during the
process of applying lettering to a glass milk bottle .
Since then, many different types of composite materials
have been invented and numerous studies performed on
the mechanics of composite structures.
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The range of application of composite materials is very
large; some of the main application areas are listed be-
low

» Electronics

» Buildings

Road transportation

» Rail transportation

» Marine Transportation

» Air & Space Transportation

M

MAIN APPLICATIONS OF HONEYCOMB
SANDWICH STRUCTURES:
Commercial aerospace:

Figures 1.4, 1.5, and 1.6 show typical applications of
sandwich structures in commercial aerospace vehicles.
These examples show the extent to which sandwich com-
posite structures are utilized in the structural parts.

» Radome: Specialized glass Prepregs. Flex core honey-
comb.

» Landing Gear Doors and Leg Fairings: Glass/
carbon Prepregs, honeycomb
» And Redux bonded assembly. Special process hon-

eycomb.

» Galley, Wardrobes, Toilets: Fabricated Fibrelam pan-
els.

» Partitions: Fibrelam panel materials.

» Wing to Body Fairing: Carbon/glass/aramid Prepregs.
Honeycombs.

Redux adhesive:
» Wing Assembly: (Trailing Edge Shroud Box) Carbon/

glass Prepregs.
» Nomex honeycomb. Redux bonded assembly
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THE ORIGINS OF SANDWICH TECHNOL-
OGY:

The first successful landing of a space ship on the moon
on 20 July 1969 was the result of the successful applica-
tion of a number of new technologies including rocketry,
computers and sandwich construction. Although public
interest centred on rocketry and computer technology,
it was only with the help of sandwich technology that
a shell of the spacecraft could be constructed that was
light in weight and yet strong enough to sustain the stress-
es of acceleration and landing. Figure 1.1 shows the wall
construction of the Apollo capsule which consisted of two
interconnected sandwich shells. Figure 1.2 shows details
of the outer shell, which comprised two thin steel fac-
ings and a honeycomb core. The inherent advantage of
sandwich construction is immediately apparent, name-
ly, high strength and rigidity at low weight.

Heat shield fusible
plastic honeycomb

Outer steel sandwich shell
steel face thickness 0.21-0.51 mm

Inner aluminium sandwich shell

Fig. 2.1: Sandwich construction of the Apollo capsule.

t=0.21-0.51mm

Tt = 0.038mm

s

]
3.2-4.8mm

Fig.: Cellular sandwich forming the outer shell of the
Apollo capsule.

MATERIALS USED IN SANDWICHPAN-
ELS
Aluminum:

Aluminumi s the third most abundant element (after oxygen
and silicon), and the most abundant metal, in the Earth’s
crust. It makes up about 8% by weight of the Earth’s solid
surface. Aluminum metal is too reactive chemically to oc-
cur natively. Instead, it is found combined in over 270
different minerals. The chief ore of aluminum is bauxite.
Aluminum is remarkable for the metal’s low density and
for its ability to resist corrosion due to the phenomenon of
passivation. Structural components made from aluminum
and its alloys are vital to the aerospace industry
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and are important in other areas of transportation and
structural materials. The most useful compounds of alu-
minum, at least on a weight basis, are the oxides and
sulfates. Despite its prevalence in the environment, alu-
minum salts are not known to be used by any form of
life. In keeping with its pervasiveness, aluminum is well
tolerated by plants and animals. Due to their prevalence,
potential beneficial (or otherwise) biological roles of alu-
minum compounds are of continuing interest.

MODELING OF SANDWICH PANELS
WITH BIO FOAM CORE:
Step-1 :- (Starting Catia V5)

Select Start Mechanical Design Part design from the
main bar
ENOVIAVS File  Edit  View

Infrastructure L4

Insert Tools J

El'r Part Design

» @ Assembly Design

Select the XY plane
7 T Qlané

Step: 2(Model of Upper face sheet 3D Model)

»  Select->Sketch->Draw a rectangle with 1ft /linch
» Exit work bench
» By using pad option —»extrude up to 11t

Ie-Mechanical Design

Shape
o 2hap

Screen Model of face sheet 1(Biofoam)

Select—=>Sketch—=Draw another rectangle with 1ft /linch
Exit work bench
By using pad option 2 extrude up to 1ft
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Screen 5.2: Model of Face sheet 2 (Biofoam)

Select XY — plane =Draw another rectangle with same
dimensions with 2 inches gap b/w them

Select = rectangle > with 2 inch thickness & extrude it up to
1feet
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Screen 5.3: Model of Bio foam Core
Model of Bio foam Core
Save it as IGS format & catia v.part file

BASIC METHODOLOGY OF ANSYS:

Ansys is followed up by the method called Finite Element
Modeling Methods (FEM)\

Finite element method:

The finite element method (FEM) (its practical applica-
tion often known as finite element analysis (FEA) is a
numerical technique for finding approximate solutions of
partial differential equations (PDE) as well as of integral
equations. The solution approach is based either on elimi-
nating the differential equation completely (steady state
problems), or rendering the PDE into an approximating
system of ordinary differential equations, which are then
numerically integrated using standard techniques such as
Euler’s method, Runge-Kutta, etc.
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In solving partial differential equations, the primary chal-
lenge is to create an equation that approximates the equa-
tion to be studied, but is numerically stable, meaning that
errors in the input and intermediate calculations do not
accumulate and cause the resulting output to be meaning-
less. There are many ways of doing this, all with advan-
tages and disadvantages. The Finite Element Method is a
good choice for solving partial differential equations over
complicated domains (like cars and oil pipelines), when
the domain changes (as during a solid state reaction with a
moving boundary), when the desired precision varies over
the entire domain, or when the solution lacks smoothness.
For instance, in a frontal crash simulation it is possible to
increase prediction accuracy in “important” areas like the
front of the car and reduce it in its rear (thus reducing cost
of the simulation). Another example would be in Numeri-
cal weather prediction, where it is more important to have
accurate predictions over developing highly-nonlinear
phenomena (such as tropical cyclones in the atmosphere,
or eddies in the ocean) rather than relatively calm areas.

Screen 5.5 : Model of Honey comb core

Layout of ansys window:

Utility Menu

lcon Toolbar Menu

Input Line Raise/Hidden Icon =

Output
Window DONEEET

Graphics Area

7 A— e
urrent Settings
[/

Screen 6.1 ANSYS window
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ANSYS GRAPHICAL USER INTERFACE
(OUT PUT WINDOW):

After starting ANSYSS, two windows will appear. The first
is the ANSYS 8.1 Output Window:

Screen 6.2 : output window

This window displays a listing of every command that
ANSYS executes. If you encounter problems, this is a
good place to look to see what ANSYS is doing or has
done. This is one location where you will find all of the
warnings and error messages that appear and the com-
mand that generated the warning/error.The second win-
dow is the ANSYS Research FS graphical user interface.

Step-1:- Preferences-> Structural->H-method-> Ok
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This is divided into 4 sections (shown on next page):
ANSYS Utility Menu

ANSYS Toolbar Menu

ANSYS Main Menu

Display window

Each section will be discussed in further detail below.

STRUCTURAL ANALYSIS ANALYSIS OF

BIO FOAM SANDWICH PANEL:
Import the CATIA file of bio foam in to ANSYS

e P ANSYS
— JUN

Screen 7.1 Catia file imported in ANSYS (Bio foam)

Step- 2:- Preprocessor->Element Type > Add-> Add->Solid>Tet 4

Node 187

Step-3:-

2
Material properties—=Material models—=>Structural > linear = Elastic 2Isotropic 2E=62000 N/mm —2>PRXY=0.334

Select new model2>E=0.02e52>PRXY=03
Step-4:-

a) Meshing > Mesh attributes=> picked volumes->Select the face sheets —»asa material 1 ->apply = Select material as

properties for middle block 2ok

b) Size controls—= Smart Size 2Basic2LVL sixe level 10 (coarse) 2ok
c¢) All areas—=manual size—=areas—>all areas—=>Element edge length=20—=>0k

d) Mesh-=>Volumes->free->pick all->ok
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Screen 7.2: Meshing (Bio foam)

Step: 5:- (Solution)
Define loads 2 apply—=structural >displacement—=>on
Areas—>select—=>one side of panel is fixed with ALL DOF—=>ok

Force or moment—=on key points—=Select the top
most corner points on the free end »ok=2>FZ->2000 KN at
free end

Screen 7.20 :Von misses Stress

RESULTS:

After fixing the one end with all DOF, assuming the panels
as a cantilever beam, applied load up to 2000 KN Point
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loads in Z - direction. At the free end & observed the
behavior in Stress in X, Y, Z —Directions & Von- misses
Stress. Hence the results are at Maximum & Minimum
Stresses are at all the directions & Displacement of all
components.

Displacement and Stresses acting on a Sandwich panel
with Bio foam core:

Displacement of X- Component

a)Minimum = -0.072295

b)Maximum = 0.078845

Displacement of Y-Component

a)Minimum = -0.015227

b)Maximum = 0.019178

Displacement of Z-Component

a)Minimum = -0.976E-03

b)Maximum = 1.15025

Stresses at X — Direction

a)Minimum = -42.9251

b)Maximum = 41.8158

Stresses at Y- Direction

a)Minimum = -21.8146

b)Maximum = 35.7779

Stress at Z- Direction

a)Minimum = -184.779

b)Maximum = 20.9707

After Fixing the one end with all DOF, assuming the pan-
els as a cantilever beam, applied load up to 2000 KN UDL
throughout the area of the beam in Z — direction . At the
free end & observed the behavior in Stress in X, Y, Z —Di-
rections & Von- misses Stress. Hence the results are at
Maximum & Minimum Stresses are at all the directions
& Displacement of all components.

CONCLUSION:

The aim of this project is to decrease the weight of an air-
craft, so by using the light weight composite materials we
can decrease the weight they are nothing but Sandwich
panels.Even though they should be high strength materials
with more stiffness. So by assuming them as a cantilever
beam, by applying loads on it we can get the minimum &
maximum stresses acting on a sandwich panels when the
loads are acting on the free end. With the analysed results
for the given parameters Hereby we conclude that

» Honey comb structures have much stiffness & heavy
weight

» Whereas bio foam with same properties with light
weight

» So we can justify that by using bio foam we can de-
crease the weight of an aircraft
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